
 Application Note 0901 

 https://s-team.sk 

Homer Autotuner: Selected Topics 
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1. Introduction 
This application note discusses the following topics regarding S-TEAM Homer Autotuners: 

• Matching range 

• Tuning speed 

These quantities can be examined using the HoSim simulation app after customizing the simulated 

Autotuner by means of loading the Tun.mem tuner characterization file pertaining to a particular Autotuner 

model.  

The HoSim simulation software is a part of your Autotuner installation. The latest version can be 

downloaded from https://s-team.sk/software, please follow the link HoSim.  

Tun.mem files for a selection of typical S-TEAM Autotuner variants are included in your HoSim 

installation. Their names reflect the Autotuner waveguide type and, where appropriate, the motors speed 

category, such as TunR26_Fast.mem.  

A Tun.mem file for your particular Autotuner unit can be found under the same name in your installation 

folder.  

2. Customizing Simulated Autotuner 
To customize a simulated Homer Autotuner, please follow the steps below: 

1. Start HoSim app. 

2. Open the System Info window (Fig. 1) by clicking View|System Info menu item, or Sys toolbar 

button. 

3. Click Load Mem button in System Info window. Navigate to the Tun.mem file for the tuner of 

interest (as noted above, it may have a different name, such as TunR26_Standard.mem) and open it. 

Now the tuner has been customized. Please note the updated settings in Tuner, Motors, and Sketch pages of 

the System Info window.  

Now, after terminating and restarting HoSim, the tuner parameters will assume their latest settings, and 

hence there is no need to reload the Tun.mem again. 

https://s-team.sk/
https://s-team.sk/software
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Fig. 1.  Tuner, Motors, and Sketch pages of the System Info window of HoSim app. 

3. Setting Measurement Conditions 
To set measurement conditions, proceed as follows. Note that the settings will not be active until clicking 

Apply button. 
 

• Open the Homer Model window (Fig. 2) by clicking the menu item Model. 

  

 

Fig. 2.  Pages of Homer Model window.  

• Click the DUT tab to define type and value of the load reflection coefficient L = M exp(j). Please note 

that by default L refers to the Autotuner output flange (see the Sketch page of Fig. 1). 

− In Type box, select the method of simulating the load reflection coefficient L: 

▪ Defined: L is defined by its Magnitude (M) and Phase () edit boxes. 

▪ Match: Load reflection coefficient will be set zero: |L| = M = 0. 

▪ Animated: Time-varying reflection coefficient, spiraling in polar diagram according to settings in 

Animation page. For details, refer to Help for Homer, topic Homer Simulation > Homer Model 

Window > Animation Page (try the settings shown in Fig. 2). 
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▪ Chart: Using a mouse click or dragging to set a load reflection coefficient in polar diagram (a 

resizable polar diagram opens after selecting Chart and clicking Apply button). For details, 

refer to Help for Homer, topic Homer Simulation > Homer Model Window > Chart. 

− Define the reflection coefficient uncertainty radius (which simulates noise) by editing the 

Uncertainty Radius edit box. Set zero for an ideal noiseless situation. Note that increasing 

averaging in CW sampling mode (e.g., via Sample Count button  ) reduces the observed noise. 

Thus, to see the full uncertainty, set Averaging = 1. 

• Click Freq/Power/Temp tab to define the following simulated quantities:  

− Generator frequency and its uncertainty in %; 

− Generator incident power and its uncertainty (noise). 

− Autotuner internal temperature and its uncertainty in degrees Celsius. 

− Two of the error flags delivered by the system (Overflow, Low Signal). 

• Click Apply to activate the settings. 
 

The Homer Model window can be kept open while running the measurement, thus enabling any changes to 

be applied “live.” 

4. Matchable Area 
The area of matchable load reflection coefficients L for a given Autotuner at a given frequency can be 

viewed in the polar diagram by following these steps: 

1. Customize the Autotuner. 

2. Set a desired magnetron frequency in the Homer Model window (Fig. 2). 

3. Set the DUT type to Chart and click Apply button in the Homer Model window. The Load 

Reflection Coefficient chart opens (Fig. 3). 

4. In Show Area box, select Matchable. Two subareas of the reflection coefficients matchable by the 

stubs 1 + 2 (the blue-bordered area) and by the stubs 2 + 3 (the pink-bordered area) will be drawn. 

Note that the reflection coefficients are related to the reference plane as discussed above. 

 

Fig. 3.  Load Reflection Coefficient window displaying the matchable area.  

Now, you can change frequency in the Homer Model window (activate it by clicking Apply) and observe 

how the matchable area will change. 

You can also experiment with the autotuning by using the following procedure: 

• Open the Tuner View window (Fig. 4) by clicking the menu item Tuner|View, or the toolbar button 

. 
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• Activate autotuning by depressing AT button in Tuner View window. 

• Start measurement. 

• Click into the Load Reflection Coefficient window, move the cursor in its polar chart and observe the 

measured reflection coefficient and the insertions of the tuning stubs. 

 

Fig. 4.  Tuner View window of the HoSim program.  

5. Tuning Speed 
Let us suppose for the moment that  

− the load reflection coefficient L is constant,  

− L lies inside the tuner matchable area, 

− generator (magnetron) frequency is constant.  

The process during which the tuner input reflection coefficient reaches a target value (normally zero) within 

a given tolerance will be referred to as autotuning sequence. One autotuning sequence consists of one or 

more autotuning steps. One autotuning step consists of the following actions, with their respective times: 

1. Measurement time tm  

2. Data processing time tp  

3. Tuning stubs movement time ts  

4. Writing time of final motor insertions to flash memory tw  

Since S-TEAM autotuners employ predictive algorithms, one autotuning step is ideally sufficient to 

complete each autotuning sequence. However, in practice, due to nonidealities, more than one autotuning 

step is sometimes necessary (a basic step plus one or two corrections with progressively shorter stub 

movements). These “nonidealities” include systematic and random measurement errors, and most 

importantly, magnetron signal impurity and instability. The latter, fairly unpredictable, factor is often 

dictated by a particular anode high-voltage generation scheme. Due to these uncertainties, which vary from 

system to system, it is meaningful to measure the tuning speed performance merely by the basic autotuning 

step, and assuming a good quality (low-ripple, harmonic) signal. Some extra time (overhead) to account for 

corrective steps can then be added. Under these assumptions, the tuning speed performance can be expressed 

in terms of a single-step autotuning time tt as 

( 1 ) wspmt ttttt +++=  

The four tuning time constituents (tm, tp, ts, tw) play unequally significant roles. 

5.1 Measurement Time 
Measurement process can be user-configured such that the measurement time tm varies widely, ranging 

typically from 100 s to several seconds. Because of this variability, it is reasonable to not consider the 

measurement time for the assessment and comparison of Autotuner speed performance. For practical 

assessments, users can correct the tuning time by adding their individually estimated measurement times tm. 

For CW sampling mode, measurement time can be estimated as  
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where 

− Ns is sample count (averaging number), 

− fs is sampling frequency. 

For Rectified sampling mode, measurement time can be estimated as  
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where 

− fR is ripple frequency, 

− NR is number of sampled ripple periods, 

− Ns is sample count. 

For Pulsed sampling mode, the measurement time can be estimated as  

( 4 ) 
max254 0.111m s st T T N= + + +  

where 

− Ts is sampling time 

− Ns is sample count 

− Tmax is maximal expected pulse repetition period. 

5.1.1 Triggering 

In case of Rectified and Pulsed modulations, and hence the corresponding appropriate sampling modes, 

waiting time for the occurrence of triggering events should also be considered. This time can be anywhere 

between zero and 2 × Ttrg where Ttrg = 1/fR for the Rectified mode and Ttrg = 1/fp for the Pulsed mode, with fp 

being the pulse modulation repetition rate. The factor 2 appears because in one measurement cycle, signal 

sampling and frequency counting are triggered successively. 

5.2 Data Processing Time 
Data processing time tp includes computation of new tuning stubs positions. It takes typically less than 10 

ms, which constitutes only a fraction of the total tuning time. It can be therefore ignored (tp  0).  

5.3 Tuning Stubs Travel Time 
The value of the tuning stubs travel time ts depends on the stepper motors type and the distances the stubs 

must travel. Since the stubs move simultaneously, the longest of the three travel distances is relevant. 

The basic stepper motor/spindle combination characteristics are  

− Step size s (mm) 

− Stepping rate fs (Hz) 

The values can be learned from the Motors page of the System Info window shown in Fig. 1 (take the lower 

of the Pull-in rate and Pull-out rate values for fs). The window also shows the maximum Travel distance 

(insertion depth) hmax, which is linked with Max steps (nmax) value by 

( 5 ) 
maxmax snh =  

The stub travel speed is 

( 6 ) 
ss sfv =  
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Travelling a distance h takes the time1 
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5.4 Flash Writing Time 
Some applications need the stubs to remain in positions even after switching the Autotuner OFF and later 

ON again. For this reason, the stub positions (in terms of motor steps) are written into the Autotuner internal 

flash memory after each stubs movement command. The process takes approximately 200 ms, hence 

( 8 ) tw = 0.2 

The flash writing time is therefore a significant limiting factor in fast Autotuners. 

5.5 Worst Case Tuning Time Estimate 

The tuning time estimates below are based on the following assumptions: 

1. Starting stub positions are zero (stubs completely withdrawn). The travel distance h then equals the 

stub insertion h. 

2. Based on the arguments above, the measurement time tm is not included, and data processing time tp 

is neglected. 

The worst case occurs for load reflection coefficients on the border of the matchable area (Fig. 3) or beyond 

because at least one of the stubs must move to the maximum insertion depth hmax, resulting in the longest 

possible travel time 

( 9 ) 
s
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h
t max

max =  

Such extreme mismatch cases are also more sensitive to nonidealities, and hence, in practice, one or two 

additional corrective steps are typically required. As suggested above, this can be accounted for by adding 

some overhead, which may be conveniently expressed as percentage u of the basic step value ( 9 ). The 

formula for the worst-case tuning time is then 
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where u is the overhead factor in percent (e.g., u = 50%). Examples for typical tuner models are shown in 

Table 1. 

5.6 Partial Mismatch 
The above formula can also be used for estimating the tuning time in the case of partial mismatch (load 

reflection coefficient inside the matchable area). In this case, hmax should be replaced by the corresponding 

stub insertion h, and hence 
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The stub insertion h needed for matching depends on both the magnitude M and phase  of the load 

reflection coefficient L=M exp(j). The dependence on phase is less significant and can be ignored for such 

estimates. A fairly useful approximation is then 
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1 Motor acceleration and deceleration have been neglected. 
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where Mmax is the maximum load reflection coefficient magnitude matchable irrespective of phase, i.e., the 

radius of the largest circle that completely fits into the matchable area (in Fig. 3 about 0.78). For M > Mmax, 

use h = hmax. 

The curve ( 12 ) is presented in Fig. 5. As evident, it is very steep close to the origin: matching of even small 

reflections requires substantial stub insertions, and hence comparatively high tuning times. For higher M, the 

curve becomes less steep. 

 

Fig. 5.  Relative stub insertion depth h vs. relative load reflection coefficient magnitude M.  

Computations for a variety of Autotuner models can be performed using the accompanying Excel worksheet 

AN0901.xlsx. An example is shown in Table 1. 

Table 1. Tuning time computations for a selection of autotuners. 

 
 

5.7 Using HoSim Simulation App 
The HoSim Homer Autotuner simulation app is a best tool for more accurate estimation of the tuning time. It 
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− for any reflection coefficient magnitude and phase,  

− at any desired frequency,  

− with any starting stub positions. 

To do so, proceed as follows: 

1. Customize the Autotuner. 

2. Open the Homer Model window (Fig. 2) by clicking the menu item Model. 

3. Set the desired magnetron frequency in the Homer Model window, page Freq/Power/Temp (Fig. 2). 

4. Set the desired DUT reflection coefficient magnitude and phase by any method described in Setting 

Measurement Conditions (except Animated). A good idea is to use the Chart option. 

5. Open the Tuner View window (Fig. 4) by clicking the menu item Tuner|View or the  toolbar 

button. Observe that unlike the “sharp” HomSoft program, the window includes the Travel Time 

display box (top left, showing the number 2294). 

6. Disable continuous autotuning by setting AT to the non-depressed position.  

7. Set the stubs to desired starting insertions (e.g., by dragging, using the up-down buttons, or clicking the 

insertion numbers). 

8. Start measurement by clicking  in the main HoSim window. 

9. Activate a single autotuning step by clicking Tuner View window the Travel Time box or  button. 

10. Notice the number in the Travel Time box. The figure represents the stubs travel time ts in milliseconds.  

11. You may wish to add some overhead and the flash writing time tw (200 ms) as discussed in the previous 

section to estimate the overall tuning time. 

12. Repeat the whole procedure for any desired conditions. Try adding in Homer Model window an 

uncertainty of reflection coefficient and/or frequency. 

13. To estimate the overall tuning time more realistically, you may wish to add other constituents as 

discussed in the previous sections: a measurement time tm, the flash writing time tw (200 ms), potential 

triggering wait times 2 × Ttrg as well as some overhead. 

 


